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HOW DOES MICROSOFT PROJECT CALCULATE DURATIONS IN
DAYS - AN EXTRACT FROM PLANNING AND CONTROL USING
MICROSOFT PROJECT 2013, 2016 & 2019

BY PAUL E HARRIS

Microsoft Project effectively records task durations in hours and the value of the duration in days is
calculated using the parameter entered in the Hours per day: field in the File, Options, Schedule tab,
Calendar options for this project: section. It is VERY IMPORTANT that all users understand that the
durations in days are calculated using ONLY the one parameter and this parameter is used with
EVERY calendar. This makes Microsoft Project difficult to use when calendars with a different number
of hours per day are being used.

For example, the Options form below shows the Hours per day: as “8”. Therefore, when tasks are:

¢ Assigned an 8-hours per day calendar then the durations in days will be correct, and
e Assigned a 24-hours per day calendar the durations of tasks in days will be misleading.

General — _ _ _
enere Change options related to scheduling, calendars, and calculations.

Display

_ Calendar options for this project: OzBuild Bid Workshop {Blz‘

Proofing Week starts on: u
Save Fiscal year starts in: u

Use starting year for FY numbering

Language
These tirmes are assigned to tasks when you enter a start or finish date

Default start time: E
Advanced u without specifying a time. If you change this setting, consider

:00
Customize Ribbon Default end time: [ 17:00| v ! matching the project.calenda!' using.the Change Working Time
command on the Project tab in the ribbon.
Quick Access Toolbar CHours per day: 8
Hours per week: |40
Add-Ins
Days per month: “

Trust Center W

oK | | Cancel

The picture below shows:

e Task 1 has the correct duration in days.
e Task 2 shows a duration that is clearly misleading.

e Task 4 and 5 display the duration in hours and are not misleading when the calendar column is also
displayed.

Task Calendar 7 | Duration ~ Stat Y| Finsh ¥ |Mon01 TueO2 Wed03 ThuO4 [Fri0s
1 |8 Hours per Day & days Mon 08:00 Fri 17:00 ]
2 |24 Hours per Day 5 days Mon08:00 | Wed00:00 | SN
4 |8 Hours per Day 40 hrs Mon 08:00 Fri 17:00 T
5 |24 Hours per Day 40 hrs Mon 02:00 | Wed 00:00 .

and finish times or assigning calendars with different numbers of hours per day whenever

@ Itis STRONGLY RECOMMENDED that inexperienced users avoid changing calendar start
possible.
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To display the duration in hours:

e The Duration is entered in: field in the File, Options, Schedule tab, Schedule heading should be
set to Hours, and then

e Existing durations in days are changed to hours by overtyping the original durations.

General Scheduling options for this project: 05 Candar .
Display Mew tasks created: Auto Scheduled
Schedule Auto scheduled tasks scheduled on: | Project Start Date
Proofing CDu[ation is entered in: v
Save Work iz entered in:
Defo sk types

New tasks are effort driven &) Tasks will always honor their constraint dates ©

Autolink inserted or moved © Show that scheduled tasks have estimated durations ©

Customize Ribbon tasks ) MNew scheduled tasks have estimated durations
Split in-progress tasks (©/

Language

Advanced

Cuick Access Toolbar | Keep task on nearest working day when changing to

Update Manually Scheduled Automatically Scheduled mode
Add-Ins tasks when editing links

v

The File, Options, Schedule, Calendar options for this project options are explained in more detail
below:

The title of these options does not clearly indicate their functionality. Options for Hours per day:,
Hours per week: and Days per month: SHOULD be understood, especially if multiple Task calendars
are used.

e This heading allows the setting of the default for All New Projects or for individual projects. This
sets the current calendar settings as the default in the Global.mpt project and is used thereafter as
the calendar settings in all new projects.

Calendar options for this project: Edited template for Book | »

Week starts on: N All Mew Projects

Fiscal year starts in: y OzBuild Bid Workshop 18
Use starting year for B Edited template for Book

Default start time: | 8:00 AM u These tir.m?s are assigned to tash.cs 1.:~.rhen you enter a
start or finish date without specifying a time. If you

Default end time: | 3:00 PM u change this setting, consider matching the project
calendar using the Change Working Time command
on the Project tab in the ribbon.

Hours per day:

iI
[ [E]

Hours per week:

Days per month: |20

[

o Week starts on: — Sets the first day of the week. This is the day of the week that is displayed in the
timescale. This setting affects the display of the calendar in the Change Working Time form. NOTE:
This is best set to Monday and not Sunday so the date displayed in a weekly timescale is a working
day.

o Fiscal year starts in: — A month other than January may be selected as the first month of the fiscal
year for companies that want to schedule projects using their financial years.

o Use starting year for FY numbering — This option becomes available when a month other than
January is selected as a Fiscal year starts in:. The year in the timescale may be assigned as the
year that the fiscal starts or the year that the fiscal year finishes.
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Default start time: — This is the time of day that tasks are scheduled to start when a start date
constraint (without a time) is applied. It is also the default time for an Actual Start when an Actual
Start (without a time) date is entered.

Default end time: — This is the time of day that tasks are scheduled to finish when a finish date
constraint (without a time) is entered. It is also the default time for an Actual Finish when an Actual
Finish date (without a time) is entered.

It is essential to match both the Default start time: and Default end time: with your
project calendar’s normal start and finish times. For example, when the Default start
time: is set earlier than the calendar normal start time, a task set with a constraint
without a time will appear to finish one day later than scheduled. Therefore a one-day
task will span two days and a two-day task, three days.

The following options need to be understood as they affect how summary durations are displayed.
NOTE: THESE OPTIONS ARE IMPORTANT. Microsoft Project effectively calculates in hours. Task
durations may be displayed in days, weeks and months. These summarized durations are calculated
based on the parameters set in Options, Calendar. These options work fine when all project calendars
are based on the same number of work hours per day. When tasks are scheduled with calendars that
do not conform to the Options, Calendar settings (e.g., when the Options, Calendar settings are set
for 8 hours per day and there are tasks scheduled on a 24-hour per day calendar), the results often
create confusion for new users.

Hours per day: — This setting is used to convert the duration in hours to the displayed value of the
duration in days. For example, a task entered as a 3-day duration and assigned a 24-hour per day
calendar will be displayed in the bar chart as 1-day elapsed duration. This bar chart duration is 1/3
of the duration value since each day is an 8-hour equivalent on a 24-hour calendar and the output
is not logical. See Task 1 below.

Hours per week: — This setting is used to convert the calendar hours to the displayed duration in
weeks. For example, a task entered as 2 weeks (10 working days) and assigned a 24-hour per day
calendar is displayed with a 3-day and 6-hour duration in the bar chart. This is 1/3 of the “normal”
duration and again not logical. See Task 2 below.

Days per month: — This option is used to convert the displayed task duration from days to months.
For example, a 0.5-month task (10 working days) on a 24-hour per day calendar is displayed as a
3-day and 6-hour duration in the bar chart and again is not logical. See Task 3 below.

Task Mon 01 Sep Tue 02 Sep Wed 03 Sep Thu 04 Sep
Duration Calendar 0|6 (12 (18| 0 | &6 (12|18 | 0 | 6 |12 18| 0 | 6 |12 18
1 3 days 24 Hours I
2 2 wks 24 Hours |
3 0.5 mons 24 Hours |

situation be avoided.

f All the durations displayed in the picture are misleading. It is important that this

Other scheduling software also exhibits the time conversion problem when using
multi-calendars. This display can lead to a great deal of confusion. To avoid
confusion when using multi-calendars, it is suggested that you only display durations
in hours.
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Display Times in 24-Hour Clock

Should you wish to display your times in 24-hour format, e.g. 17:00hrs instead of 5:00pm then:

e Select from the windows menu Control Panel, Region tab, or similar commands if you are not
using Windows 8.

e Select Formats, select the Short Time & Long Time tab and

e Change the time format from h:mm:ss tt to HH:mm:ss or H:mm:ss.

Working with Calendars with Different Hours per Day

There are some workable options to ensure that the durations in days are calculated and/or displayed
correctly:

All the calendars used on a project schedule should have the same number of hours per day for
each day. This value is entered in the Hours per day: field in the Options form below. Then all
durations in days will calculate correctly.

When there is a requirement to use a different number of hours per day (in either the same
calendar or in different calendars) then all durations should only be displayed in hours and the Task
Calendar displayed, as per the picture below. Two examples of how this may occur are when:

> There is an 8-hour working day Monday to Friday and a 4-hour working day on Saturday, or

> Different calendars are required on a project, for example when some tasks are assigned an 8-
hour per day calendar and some a 24-hour per day calendar.

The Duration is entered in: field in the File, Options, Schedule tab, Scheduling options for this
project section should be set to Hours.

A Customized Field may be used to calculate and display the correct duration by using a formula.
The example below uses the Duration1 field to calculate and display the correct duration in days of
a 24-hour per day calendar using a formula.

Task Calendar

September
Durationl | Duration Start Finish Sun 31 (Mon 01| Tue 02 Wed 03 Thu 04 | Fri 05

Field

@Task

8 Hours per Day 5days S5days = Mon 08:00  Fri17:00
24 Hours per Day

1.65days S5days Mon 08:00 Wed 00:00

(") Resource Project Type:

Field

Duration1

Duration2
Duration3
Duration4
Curation5
Durationé
Duration?

Edit formula

Curation =

ilf(rl’ask Calendar]="24 Hours per Day" [Duration]*0.33,[Duration])

| Rename... | | Delete

Custom attributes

O MNone O

Caleulation for task and grouy Insert: | Field + | | Function + | Import Formula...

@None ORollup: Ma:

Calculation for assignment ro | oK || Cancel |

@ MNone ORO” down unl

I [elmedn ] [h] S]] wolfor]wer
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To create the formula displayed above:

o Select Project, Properties, group, Custom Fields to open the Custom Fields form,
o Select Duration 1 from the Type drop-down box in the top right-hand side of the form,

e (Click on the button to open the Formula form and enter the formula as required.
e The formula in the picture above will work for a schedule that has two calendars in use.

e The formula above is

|If([Task Calendar]="24 Hours per Day",[Duration]*0.33,[Duration])

To see more explanations like this then buy Paul Harris’ Microsoft Project book by which is available in

paperback, spiral, Kobo, Kindle and iTunes from:
https://www.eh.com.au/MSP2019.html

These books are intended to be used:

> As a self-teach book and a two-day training course
handout.

> Instructor PowerPoint slide shows are available for
purchase and free pdf versions are available to
educational organisations.

Eastwood Harris Pty Ltd,

Planning and Scheduling books and training material:

» Microsoft Project,

» Oracle Primavera P6 and

> Elecosoft (Asta) Powerproject

https://www.eh.com.au

PLANNING AND CONTROL

MICROSOFT PROJECT
2013, 2016 & 2019

This book is designed for users of earlierversions to upgrade their skills and for
new plannersto learn the software. It starts with the basics required to create
aschedule, through resource planningand on to the more advanced features,

The warkshops in this publication have been updated and improved.

© Eastwood Harris Pty Ltd




<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /None
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.0000
  /ColorConversionStrategy /sRGB
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo true
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments true
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 300
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 300
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /CreateJDFFile false
  /Description <<

    /BGR <>
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e9ad88d2891cf76845370524d53705237300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc9ad854c18cea76845370524d5370523786557406300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /CZE <>
    /DAN <>
    /DEU <>
    /ESP <>
    /ETI <>
    /FRA <>
    /GRE <>

    /HRV (Za stvaranje Adobe PDF dokumenata najpogodnijih za visokokvalitetni ispis prije tiskanja koristite ove postavke.  Stvoreni PDF dokumenti mogu se otvoriti Acrobat i Adobe Reader 5.0 i kasnijim verzijama.)
    /HUN <>
    /ITA <>
    /JPN <FEFF9ad854c18cea306a30d730ea30d730ec30b951fa529b7528002000410064006f0062006500200050004400460020658766f8306e4f5c6210306b4f7f75283057307e305930023053306e8a2d5b9a30674f5c62103055308c305f0020005000440046002030d530a130a430eb306f3001004100630072006f0062006100740020304a30883073002000410064006f00620065002000520065006100640065007200200035002e003000204ee5964d3067958b304f30533068304c3067304d307e305930023053306e8a2d5b9a306b306f30d530a930f330c8306e57cb30818fbc307f304c5fc59808306730593002>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020ace0d488c9c80020c2dcd5d80020c778c1c4c5d00020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /LTH <>
    /LVI <>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken die zijn geoptimaliseerd voor prepress-afdrukken van hoge kwaliteit. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /POL <>
    /PTB <>
    /RUM <>
    /RUS <>
    /SKY <>
    /SLV <>
    /SUO <>
    /SVE <>
    /TUR <>
    /UKR <>
    /ENU (Use these settings to create Adobe PDF documents best suited for high-quality prepress printing.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
  /Namespace [
    (Adobe)
    (Common)
    (1.0)
  ]
  /OtherNamespaces [
    <<
      /AsReaderSpreads false
      /CropImagesToFrames true
      /ErrorControl /WarnAndContinue
      /FlattenerIgnoreSpreadOverrides false
      /IncludeGuidesGrids false
      /IncludeNonPrinting false
      /IncludeSlug false
      /Namespace [
        (Adobe)
        (InDesign)
        (4.0)
      ]
      /OmitPlacedBitmaps false
      /OmitPlacedEPS false
      /OmitPlacedPDF false
      /SimulateOverprint /Legacy
    >>
    <<
      /AddBleedMarks false
      /AddColorBars false
      /AddCropMarks false
      /AddPageInfo false
      /AddRegMarks false
      /ConvertColors /ConvertToCMYK
      /DestinationProfileName ()
      /DestinationProfileSelector /DocumentCMYK
      /Downsample16BitImages true
      /FlattenerPreset <<
        /PresetSelector /MediumResolution
      >>
      /FormElements false
      /GenerateStructure false
      /IncludeBookmarks false
      /IncludeHyperlinks false
      /IncludeInteractive false
      /IncludeLayers false
      /IncludeProfiles false
      /MultimediaHandling /UseObjectSettings
      /Namespace [
        (Adobe)
        (CreativeSuite)
        (2.0)
      ]
      /PDFXOutputIntentProfileSelector /DocumentCMYK
      /PreserveEditing true
      /UntaggedCMYKHandling /LeaveUntagged
      /UntaggedRGBHandling /UseDocumentProfile
      /UseDocumentBleed false
    >>
  ]
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


